¢ENTE ROCK STAR

An intelligent, microcontroller-based electronics and CAD/CAM project

* Learn about MIDI
music on page 20.

A

A 3D rendering of a project created with GENIE
Rock Star. The design shown above has a single-
panel acrylic guitar body on which has been placed
some custom artwork.

Contents 2 in I

Introduction 2

The GENIE Audio Kit 4

Incorporating GENIE into a product design 5

Creating a single-panel design 8

Creating a double-panel design 10 A
Creating your own designs 12 The GENIE Rock Star project is built
Modelling the GENIE Audio Kit 14 around the GENIE Audio Kit.
Programming the GENIE to play music 15 o .
Choosing which music is to be played 19 The GENIE Audio Kit is also used in
Understanding MIDI music and audio 20 the GENIE Cuddly Creatures project
Responding to inputs from the push switch 21 (which has real sound effects). So if
Responding to inputs from analogue sensors 22 you have the GENIE Audio Kit, you
Controlling the two light-emitting diodes (LEDs) 23 can choose to make either project.
Playing more than one tune 24

Building the GENIE Audio Kit 25

Powering the GENIE Audio Kit 29 All of the design files for this _¥
Downloading a program to the GENIE microcontroller 30 project can be downloaded
Fault-finding and troubleshooting 31 from genieonline.com/rockstar

’ll This worksheet is copyright © New Wave Concepts Limited. All rights reserved.
It may be reproduced for classroom or educational use.  genieonline.com

NEW WAVE CONCEPTS Page 1 of 31 & GENIE Rock Star.pdf & Version 2.1



NEW WAVE CONCEPTS

GENIE Rock Star Project

The GENIE Rock Star shows how you can use the GENIE Audio Kit to
apply computing and embed an intelligent, microcontroller-based
electronic circuit into the products that you design and make.

Through a range of musically-
themed projects, you will learn the
various techniques involved in
developing a modern, high-tech,
electronic toy, from the design of
the panels through to computer
programming and construction of
the circuit (see page 3).

S

o

lri

GENIE Rock Star was produced
with the kind assistance of Mark

Once you have learned these skills, Gooding, Billericay School.
you will then be able to apply

them to your own projects.

A

3D renderings of a selection of
GENIE Rock Star projects.

Equipment needed

For the GENIE Rock Star project you will need The materials and equipment needed for the

at least the following: body of the project will vary depending on
A GENIE Audio Kit and download cable. your own choices, but may include:
Three AA batteries (new or fully charged). Cardboard (cheaper, but less sturdy) or

acrylic (recommended) for the body.

Soldering iron, lead-f Id d wire.
oldering iron. lead-ree solder and wire CAD for the design of the body panels

Two 3mm (M3) size counter-sunk screws and CAM (such as a laser cutter) for
with matching nuts (the screw length will manufacturing. These are optional, but
depend on your choice of design) along will result in a higher-quality end product.

with a suitable screwdriver.
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GENIE Rock Star Project

Introduction 3

The following list outlines many of the ideas and
skills that will be introduced as you step through
this GENIE Rock Star project.

Product design

¢ Using CAD/CAM in a product design
2-D and 3-D modelling
Embedding an electronic circuit into a design

* o o

Selection of product materials

Computer programming

Programming using flowcharts
Responding to inputs
Controlling outputs

Digital and analogue signals
Variables and calculations

* 6 6 6 o o

Downloading a flowchart

Science and mathematics * STEM is Science, Technology,

. Engineering and Mathematics.
¢ Sound waves and frequencies 8 8

¢ Power, voltage and resistance

Electronic systems

Programmable microcontrollers
Digital music formats

Circuit simulation and modelling
Using printed circuit boards (PCBs)
Identifying electronic components A
Soldering components to a PCB

® 6 6 & O o o

A 3D rendering of a
GENIE Rock Star project
created with a single-
panel design. The GENIE
Audio Kit is mounted on
top of the panel, with a
battery box underneath.

Fault-finding and troubleshooting
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GENIE Rock Star Project

The GENIE Audio Kit 4

The GENIE Rock Star project is based around the GENIE Audio Kit.

The GENIE Audio Kit, shown on the right,
is an intelligent, programmable electronic
circuit that can play real MIDI music (see
page 19) through its loudspeaker.

At its heart is a GENIE 14 microcontroller.

This is an integrated circuit (or IC) that
controls the other components on the
circuit. It is programmable, meaning that
you can change how it behaves simply by

downloading different programs from your o )
computer onto the microchip. A GENIE Audio Kit (shown on its

own, without a product design).

The picture below highlights the major parts of the GENIE Audio Kit. These will be discussed in more

detail later. A full list of the parts contained within the GENIE Audio Kit can be found on page 26.
v

GENIE 14 microcontroller

Download socket
Light-emitting
diode (LED)

Light-dependent
resistor (LDR)
optional, not

supplied with kit

Push
switch

2 ml Product Design Tips!

The GENIE Audio Kit is also used in
the GENIE Cuddly Creatures project
(which has real sound effects). So if
you have the GENIE Audio Kit, you
can choose to make either project.

Printed circuit
board (PCB)
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NEW WAVE CONCEPTS

CENTE

Incorporating GENIE into a product design 5

GENIE Rock Star Project

The GENIE Audio Kit will be g
incorporated into a product design

to create a finished project.

To do this, we will make use of the
fact that the GENIE Audio Kit has
been cleverly designed so that a
battery box can be mounted directly
to the back of the printed circuit
board (see the picture on the right). »

For the GENIE Rock Star, we will extend this idea and place a panel (with similarly designed mounting
holes) between the battery box and the electronic circuit. All three will then form a rigid structure.

From the underneath of the GENIE Audio Kit we can see the location of
the two screws that will be needed to mount the printed circuit board to
both the battery box and the panel forming the body of the product:

v

View from underneath
(shown without a panel)

Mounting screws

It is recommended that the mounting screws have counter-sunk heads to
ensure that they do not obstruct the battery cells when they are fitted.
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GENIE Rock Star Project GE N 'E

Incorporating GENIE into a product design 6 2|

The screws are mounted such that their heads
are in the bottom of the battery box, with the
screw threads going up through the panel and
attaching to the upper-side of the printed circuit
board (PCB). A nut keeps each screw in place.

Screw and nut shown holding the
printed circuit board to both the panel
and the battery box underneath.

The screws need to be 3mm in diameter (known as M3-size screws). The length of the screw will vary
depending on the thickness of the panel used in the design—a length of about 15mm is usually sufficient.

From the diagram below you can see the physical dimensions of the printed circuit board as well as the
position and size of the two mounting holes. This information is useful when designing your own panels.

v

74mm
2.91”

Y

Height

The PCB’s height including
= components, legs and soldering, is
1‘ """""" E in approximately 15mm (0.6").
0o

A

T Mounting
£

There are many large holes, but the
) 7 3mm two indicated by the arrows are
— (M3) designed for mounting the PCB.

1.92”7

49mm —— 5

These holes have a diameter of
3mm, which makes them suitable
TR for use with M3-size screws/nuts.

|

o
I- """""" © 8 The spacing between the two holes
is 30mm (1.187).

| The other holes were not designed
- 28mm — . .

110" for mounting and are described on

) the power and loudspeaker pages.

Design Tip! If you have Circuit Wizard 4, you can use that software’s built-in CAD/CAM design tools
to automatically calculate all of the necessary panels and mounting holes.

<
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Incorporating GENIE into a product design 7

GENIE Rock Star Project

In addition to mouinting the battery box, we must also consider
how to mount the loudspeaker.

For the GENIE Rock Star project, we will take advantage of another
cleverly-designed feature of the GENIE Audio Kit: its useful ability to
mount the loudspeaker directly onto the printed circuit board.

You will notice that the printed circuit board has
a large semi-circular cut-out on one side. The
size of this cut-out is designed to fit around the
central body of a standard 50mm loudspeaker.

The loudspeaker can slot into the circuit board.
v

Once in position, the loudspeaker will sit over
the many sound holes. These holes allow the
sound waves to travel through the circuit board. i

When finally constructed later on in the project,
we suggest adding glue at contact points
between the printed circuit board and the
metalic part of the loudspeaker body. This will
give the loudspeaker even more stability.

Slot into
the board

A 3D rendering of a finished GENIE Rock Star
project, showing the mounted loudspeaker.
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GENIE Rock Star Project

Creating a single-panel design 8

The first suggested design is the simplest and involves mounting g S

the GENIE Audio Kit circuit board onto a single flat panel.

s

An example of this type of »
design can be seen on the
right. In this case, a clear
acrylic panel has been used to
form the body of the guitar. GENIE Audio Kit

As described previously, the Qeeclit board

battery pack is mounted on
the underside of the panel and
attached to the circuit board
by two screws.

Acrylic panel

Battery box

A

The two examples shown above have their panels made out of an acrylic material,
which is ideal for this type of project as it results in a strong, rigid structure. Acrylic is
available in a variety of colours (both opaque and transparent) and is well suited to
computer-aided manufacturing (CAM), such as with a laser cutter.

Wood panel < Wood, shown left, is equally suitable.

Metal, although strong, is not recommended as
it may result in an electrical connection wih the
underside of the circuit board (metal is a
conductor and will affect the behaviour of any
circuit with which it comes into contact).

A lower-cost approach involves selecting a thick
cardboard material. Cardboard will be damaged
more easily, but is great for quick projects, such
as when creating prototypes. You can also draw
directly onto the cardboard itself, allowing you
to mock-up ideas for any artwork that is going
to go on the top of the body as well.
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GENIE Rock Star Project GE N 'E

Creating a single-panel design 9 2‘

There are six guitar body shapes from which you can choose for the panel. These are shown below,
though not to scale. Each has a large hole for the loudspeaker and two smaller holes for mounting the
GENIE Audio Kit. These panels were created in Circuit Wizard 4. If you do not have Circuit Wizard 4,
you can download the shape files (in .dxf format) from genieonline.com/rockstar

Shape file

Shape file
Guitar 1 - Single

Guitar 2 - Single

Shape file

Shape file
Guitar 3 - Single

Guitar 4 - Single

Shape file

Shape file
Guitar 5 - Single

Guitar 6 - Single

Product Design Tips!

You are not limited to these six shapes. Why not design your own guitar shape? To start, you can use
Circuit Wizard 4 to modify one of these existing designs, or alternatively create one from scratch.
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Creating a double-panel design ]O

GENIE Rock Star Project

A second, more sophisticated design involves mounting the GENIE Audio Kit circuit board inbetween
two panels to form an enclosure. The two panels have the same basic shape, but differ in the number
and type of mounting holes that are present. Pillars are used to separate the two panels.

Mounting pillar. A pillar height of 12mm is
recommended for this type of design. The
pillars are fixed in place by screws at each end.

Holes on the upper-most panel allow the printed
circuit board’s inputs and outputs to be visible
and accessible (and to not block the loudspeaker).

The GENIE Audio Kit is mounted to the bottom
panel, with the battery box underneath.

The two panels in this type of design are well suited to both acrylic and wood. Metal, being a good
conductor, should not be used for either panel. Cardboard lacks the rigidity required for mounting the
pillars and therefore cannot be recommended, even for prototypes or mock-ups.

The upper panel is
an ideal location
for placing more

elaborate artwork.
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Creating a double-panel design ]] 2|

There are six guitar body shapes from which you can choose. Each guitar is made up of a top panel and
a bottom panel. The two panels for the first guitar shape are shown below (though not to scale).

The top panel has ten holes in total.
Shape file The holes marked (a) are to allow
Guitar 1 - Double (Top) the light-emitting diodes (LEDs) to
poke through. Similarly, the two

holes marked (b) are for the push
o switch and optional light sensor.
The large hole (or a grille if
is for the loudspeaker and

you have Circuit Wizard 4)
the remaining five holes are

for mounting the pillars.

There are eight holes on the
bottom panel. Two of the holes (c)
are for mounting both the GENIE
Audio Kit and the battery box.

v
()
$

As with the top panel, the other
holes are for the loudspeaker and
mounting pillars.

Shape file
Guitar 1 - Double (Bottom)

The top panels for the other five shapes are pictured below. If you do not have Circuit Wizard 4, you
can download the shape files (in .dxf format) from genieonline.com/rockstar

Guitar 4

Guitar 2

Product Design Tips!

You are not limi
. Imited to thes
SIX shapes. Why not designe

Guitar 6 Your own guitar

shape?
To start,
Wizard 4 software
One of these existin

YOu can yse Circuit

to modify
8 designs.
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CENTE

Creating your own designs ]2

GENIE Rock Star Project

Now that you have seen how the single- and double-panel designs are put together, you may be ready
to create your own designs. You may wish, for example, to modify an exsiting guitar body shape, create
a new shape or even create an entirely different type of musical toy!

All of the designs shown in these worksheets were created using the CAD/CAM design tools within the
Circuit Wizard 4 software. By combining both electronic circuit design and CAD/CAM panel design,
Circuit Wizard 4 was able to automatically calculate and produce all of the necessary mounting holes.

Once created, the design outlines were then exported in .dxf format for further editing and manufacture.

&,pm;nssm—Newﬁessin—[ﬁuitarpmiuu5ing|e.des] _o| x| | The 3D models were a“ created using the
£P Fle Edt Yiew Select Line Constraint Feature Assembly ‘Workplane Tools indow Help =& x|
(2 S &5 B RX[onienn B2 S 50 6600020 Pro/DESKTOP 8 CAD software. You can

|85 15| BERR|s -<c» 0 |FMaPussan 3| download these files from our website at:

genieonline.com/rockstar

=TE
Edit Uiew Select Line Comstraint Festure Assembly Workplane Tools ‘Mindow Help -z
SHS| & BRRX |9 [z~ bt &6/ 2|8
G EERR|E-G - |B|PAaE WUOBDD S
e
2
o
‘e
‘@
B
]
- =
Ready A :
. -
Product Design Tips!
i d in these
The designs presentec e 7
worksheets are only in 2nae
toactasa starting p((j)m for
ive ideas N
your own cxjea’uv ) |
product designs. J/:/—'/-M}}-
yYou can design you owr;\ e
products and then use t -
instructions to incorporate
GENIE Audio Kit. A
A computer rendered

3D design.
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CENTE

Creating your own designs ]3

GENIE Rock Star Project

When creating your own project designs, you may find it useful to refer to the diagram below. It details
the precise sizes and locations of the holes needed for the light-emitting diodes (LEDs) and the sensor(s).

If you have Circuit Wizard 4, these holes and mounting details can be created automatically.

5mm
0.20” —O & 7mm

39mMm —— 5
%)
O
N 3
N3

1.54”

O
Q
3
3

5mm

0.20" ‘
--—>» | «<— 30mm ——|—
10mm 118 3mm
0.39” 0.12”

< A 3D rendering of a
single-panel guitar design.

’ll This worksheet is copyright © New Wave Concepts Limited. All rights reserved.
It may be reproduced for classroom or educational use.  genieonline.com

NEW WAVE CONCEPTS Page 13 of 31 & GENIE Rock Star.pdf ¢ Version 2.1



GENIE Rock Star Project

With the product design chosen, we can
progress onto the making the project come
to life through the GENIE Audio Kit.

The intelligence is provided by a sequence of
instructions that are created on a computer
and then downloaded to the microcontroller.
This process is known as programming.

With GENIE, the instructions can be in the
form of either graphical flowcharts or (the
more advanced) BASIC text commands.

For the GENIE Rock Star project, we will be
programming using flowcharts.

Modelling the GENIE Audio Kit ]4

A CAD model of the
GENIE Audio Kit.

Traditionally, developing these instructions has been difficult, however just as with computer-aided design
(CAD), we can take advantage of computer modelling to develop and test a design before it is built.

R Circuit Wizard - [Audio Kit.cwz]

|€ Fle Edt Yiew Project Window el

I An example of computer

D& o[, n a8 5[5 Q 7|+l

Debug Buid ;Iilil‘ . .
modelling is shown left.

- 2oy ‘ SR 21007 | MO JUSUND  PHOM, [F3Y  BULON

A computer simulation model of the

|
Here we are using Circuit
Wizard 4 to simulate an
electronic circuit model of
the GENIE Audio Kit.

Circuit Wizard 4 allows us

to run the simulation and
J see how our flowchart
behaves as we interact with
it. We can detect mistakes
early on, saving time.

One example of this can be
seen in the picture. Here we
have asked the software to

GENIE Audio Kit in Circuit Wizard 4. colour each connection a
o different colour based on
+J5;I Time: [55.8855 | 2‘34KH2_\QIZUU% U [Ready = 7 the VOItage at that pOint.

You can find the Circuit Wizard 4 design and simulation files within its Microcontroller Resources.

For those without access to Circuit Wizard 4, you can instead use the free GENIE Programming Editor
available from genieonline.com/editor. This software allows you to write and download your
flowcharts, but does not enable you to design, simulate and test your electronic circuits on the screen.

This worksheet is copyright © New Wave Concepts Limited. All rights reserved.
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GENIE Rock Star Project

Programming the GENIE to play music ]5

Creating a flowchart to control the GENIE Audio Kit requires either the GENIE Programming Editor
software or version 4 of the Circuit Wizard software. The GENIE Programming Editor software is
described here; for information on using Circuit Wizard 4, please see the following page.

Run the GENIE Programming Editor by clicking on its icon. Once it loads, click on the New button on
the toolbar or choose New from the File menu. You will then see the screen below.

SEE ]@ File Edit W¥ew Program Window Help
Q{k D& a| ) o« 8- [k5Q % &

A

The GENIE Programming
Editor icon.

The GENIE Programming »
Editor software.

At the top of the main GENIE Programming Editor window is the
toolbar. Along with the normal buttons, such as Open, Save, Print and
Undo, on this toolbar you will also find buttons for controlling your
flowchart or BASIC programs.

A Start command is placed for you in your flowchart.

On the right of the main window is the Gallery. It is from here that you
will select which other commands you wish to include in your flowchart.

Program Settings

Choose the type of microcantroller you wish to o
use in your Fowchart program:

GENIE 14 [02 cenie g Cancel |

H

¥2 GENIE |

-+ GENIE Flowchart Editor - [Untitled] =10] =]
=l x|
|
— |a Flowchart Symbols j ‘
=
Program Control &
ol
A GEMIE microcontroller can be made to perfarm R
different tasks by connecting together Aowchart
carnrnands. Each commmand will be run in tum. (=]
I
W Starting and stopping o
T
Start i
Sturt Start the Aowchart o1
programn. £
. o
Stop =
F T
programn. £
¥ Common commands
Digital
Test the inputs with &
given pattem,
Outputs
Set the outputs to a
given signal pattem,
High
Set an output signal
to high Jogic 1),
Low
Set an output signal
to low dogic 0).
Walt
Wait For 3 period of
time (in seconds),
A larger range of (rore powerful) Aovcharting
| commands are awailable. Click an one of the links
belows for a more comprehensive list: d
[0 QR 100% *FusE < [Ready Y

VHEE | < Next, you need to tell GENIE which type

of chip you are using. To do this, click on

the Microcontroller button on the toolbar
and choose Program Settings.

Select a GENIE 14 chip from the list. The
inputs and output signals for this type of
microcontroller are fixed, so just click on
the OK button to continue.

You are now ready to draw a flowchart.

5 Inpuis, & OuipoEs (QB-Q8) = This is described on page 18.

NEW WAVE CONCEPTS
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GENIE Rock Star Project

Programming the GENIE to play music ]6

Circuit Wizard 4 is our flagship software combining GENIE programming, circuit design and simulation
along with the a range of built-in CAD/CAM design tools. The guitar panels, circuits and flowcharts for
this project were all created using the Circuit Wizard 4 software.

< The Circuit
Wizard 4 icon.

To run Circuit Wizard 4, double click on
its icon (pictured above).

Once it loads, go to the Help menu and
choose Microcontroller Resources. This
opens a window where you can access a
wide range of resources that show how
GENIE can be used to add intelligence to
your designing and making projects.

On the front screen are six areas for you
to explore:

‘Lighting and Sensing’, ‘Sound and Music’
and ‘Motors and Robotics’ all provide
information on how to use and control
particular inputs and outputs.

‘Design and CAD/CAM’ is where you can
learn about the built-in panel design tools
and access resources for this project, such
as the one shown on the right (this is an
example of single panel guitar design
within the Circuit Wizard 4 software).

Once you are ready to progress your
knowledge, you can access the topics
within the ‘STEM Activities’ section. Here
you will find information on the
computing, scientific and mathematical
principles behind the GENIE system, as
well as starting points for engineering
your own electrical or electronic circuits.

The final area, ‘Further Information’,
provides access to support worksheets for
the various kits and components.

GENIE Microcontroller Resources =]
= =7

|

GENIE
Microcontroller Resources

‘Welcame to Microcontroller Resources, where you can learn how to use GEMIE
to add intelligence to your designing and making projects, Click on a topic to begin:

.28
Lightir;g and - Design and
CAD/CAM

Sensing

.27

I L, > s
Sound and 3 " STEM
Music Activities

‘ |

ﬁ i ‘ ' ¥ %‘*JA. <
> ﬁ%mators and T 7y Further
Robotics Information

To create a blank, new project, click bere or choose New... from the File menu, You

Circuit Wizard 4
M icro co ntro I l er can return here by choosing Microcontroller Resources in the Help menu,
<]
Resources window. Z

Viewing a guitar design resource.

S B B B Dok Wede Heb =il
IDEE &« s« W5 LAY RO 4ard Gl 0| D@

- Gny | EARDeT AwWo] BN PURY ARLSSS ey

.
it S s 8% B wh G ]

V / /Ll
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CENTE

Programming the GENIE to play music ]7

GENIE Rock Star Project

In addition to simulating just the GENIE flowchart, Circuit Wizard 4 also allows you to also simulate the
flowchart in context with the printed circuit board, as can be seen below.

TR W =9l Amodel of the GENIE
] File Edit Wiew Projech” Win Help = Audio Klt

JorEE S o dl, how| @B Q| Ll
=0\ / Run button | You can click on the

Design and Flowchart
tabs at the bottom of
the window to switch
between the different
pages of the design.

| 2.0y | sjaaa 1607 MO JUBLND  plog, ey | [FULOKN

i
“ | With a GENIE Audio Kit
< M 2 Interactive model selected or
® . . R (o) input drawn (as described on
31.75k
g Virtual multimeter Input sensor ) )
o page 14), simply click
T —= on the Run button on
N (= the top toolbar.
When you simulate a
Page tabs circuit, Circuit Wizard 4
— - will model both the
‘ﬁ Design /i Flowchart: PCB1 £ Bill of Materials u | _’I_I flOWChal‘t and the
Fress F1 Forimee 7 Time: 32,9675 *| ta4kHz  |Q too% S UsE * | Ready ) circuit’s electronics.
Whilst the model is simulating, you can take A wide range of instruments and tools allow you
readings with the mouse (for example, by to check your circuit before building (this also
moving over a track or pad) or control the applies to circuits you’ve designed yourself).

animation by choosing one of the options from

In the example above, a virtual mulimeter is
the left-hand Style toolbar. P

being used to check the voltage on pin 3 of the

The two most common styles to view when GENIE microcontroller. This pin is where the
running a simulation are: connection to the light sensor (input ‘A/D4’, see
¢ Current Flow. When selected, the software page 23) comes into the chip.
will animate the flow of electrical current in Simulation is able to show that as the light sensor
the circuit. input is adjusted (via the interactive control), the

+ Logic Levels. Shows the high or low digital voltage on pin 3 of the microcontroller changes.

logic levels at each part of the circuit. Voltage, current, power and charge can all be
measured and tested on the screen.
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Programming the GENIE to play music ]8

GENIE Rock Star Project

< The first flowchart we will look at is shown on the left. It plays a
tune and then repeats. The LEDs will flash in time with the music.

All GENIE flowcharts begin with a Start command. When running
the flowchart, GENIE simply follows the arrows. Each command
that GENIE encounters while following the arrows will be run.

With most commands, including the two shown here, arrows go
both into and out of the command.

Gallery F
When you create a new flowchart, a Start command will be | 53 Flowchart Symbols = &
placed automatically on the page. To add other commands, BiE
you should use the Gallery. Program Control o
If the Gallery is not visibile, click on the Gallery tab that >[I AAEEmGemirely b e taperai |
. . . R . ifferent tasks by connecting together Aosechart
appears to the right of application’s window. From here you cornmands. Each command will be run in tum. =]
can drag commands onto the page. w Starting and stopping &
]
For the flowchart above, we will want to locate the Tune Start =
. . Start Start the Aowechart 4
comand and drag it below the Start command. To locate it, e E
you will need to scroll down through the list of commands. - 2 =
ﬁgthis Aowchart 2
When you drop a command below (and close by) another et g

one, a line and arrow will be placed automatically. To add
the second line (the one looping back to the Start command),
you need draw it using your mouse.

* Common commands

Digital
Test the inputs with a
given patkem,

< Lines can be drawn from any one
of the three squares shown on the
Tune command.

Qutputs
Set the autputs to -
given signal

1L

Move the mouse over the bottom
| ¥ square then click and release the
left mouse button.

Now move the mouse down and to the left. A line will follow »

your mouse.
Click with the left mouse button to add a bend when you are m
not over anything. Keep moving the mouse upwards so that it

is level with the Start command. Click again to add a second
bend and then move the mouse right until the square appears.
When you are over the square, press the left mouse button a

final time to connect line to the Start command. ! /

’ll This worksheet is copyright © New Wave Concepts Limited. All rights reserved.
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GENIE Rock Star Project

Once you have added a Tune command to your flowchart, you must next select the MIDI music that is
to be played when the command is run (you can learn more about MIDI on the next page).

Click on the Tune
command that you
wish to change (this is
not needed if there is
only one command).

For those using Circuit Wizard 4, you can select MIDI tunes through the
Music Centre.

| e

Once done, open the
Music Centre and move
the mouse to the right-
hand edge to reveal a
list of available tunes.

v
Tune Properties Click on a tune to select it B[ 17 (Custam Tune)
Play a built-in o custom musical bune: (Selecting one Wlth a folder B ol 5ol
Hode: carcel_| icon will bring up the list of B ey rslons |
e [J7 0o e r b | tunes in that folder). ggﬁm_
assic
Ghannels G [ (€l 1771 Event =l
Impork. .. | jl_.
[™ Play tume in the background
I |Repet playing rtlstoped < With the GENIE Programming Editor, you should instead double-
Signals:  (requires & udspeatker autEuty C|iCk With the left mouse button on the Tune Command.
¢ ..ﬁ%ﬁﬁl& First you must select the MIDI option.
lay a built-in or custom musical tune: . "
e ™ Next, click on the Signals so that they
== _canel | match the ones shown on the far left. If
Tune: [ J7 (o Tune) =] bep | the signals are currently empty, you
Y e should click on signal number 4 once,
Finally, click on the » @ Iingle el followed by signal 2 and then signal O.
Tune drop-down box & Merry Chritmes
¢ | a list of gg:i‘l:e’“ These steps are not needed if you are
‘?l rg‘l’ei alls X 2 Classic modelling the GENIE Audio Kit within
ignals: . . . .
ba]:/al a el lf;es' $ saneki | event Circuit Wizard 4 because it can select
'ti or;:', |S§ ecting Orfﬁ %E::le the settings automatically, since it
wi a' older lcon. Wi [JRock knows which printed circuit board you
bring up the list of _ |5port .
. Caption: DTV are uslng.
tunes in that folder. L —-————————

Because GENIE uses MIDI, you are not limited to the tunes that come with the
software. With both Circuit Wizard 4 and GENIE Programming Editor, you can
import MIDI tunes from other musical products, such as Sibelius or Cubase. To
import, simply drag a MIDI file onto the Music Centre or Tune windows.

V / /Ll
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The GENIE microcontroller at the heart of the GENIE
Audio Kit stores tunes in a musical format known as MIDI.

MIDI is short for Musical Instrument Digital Interface and is
a digital standard developed in the early 1980s, primarily
to control keyboard synthesizers (though it later progressed
into electronic drum sets and other musical instruments).

Unlike musical formats such as MP3 which store music as a
series of waveforms or samples, MIDI instead works by
storing numbers representing the actual musical notes being
played (with 60 being middle C).

Because MIDI stores just the pitches and durations of each
note, it takes up far less space, however it does mean that
MIDI cannot record singing voices.

MIDI was used to play music in video games in the 1980s
and 1990s and for ringtones on second-generation mobile
telephones, from around 2002.

You can learn more about MIDI via the following
Wikipedia article: http://en.wikipedia.org/wiki/MIDI

A low-cost home MIDI keyboard. _
..uuu“““

GENIE supports 16-channel MIDI music, which means that
up to 16 notes can be played back at the same time. This
allows GENIE to play complex tunes involving chords.

The GENIE Audio Kit works by taking the notes within the
MIDI file and then vibrating the loudspeaker cone at the
correct frequency. These sound frequencies are measured in
Hertz (Hz), which is the number of waves per second.
Humans can typically hear from about 10Hz to 10,000Hz.

The frequency determines the pitch of the sound. Higher
frequencies result in higher (treble) sounds, whereas lower
frequencies result in lower (bass) sounds.

A MIDI synthesizer in a recording
studio. Image courtesy of Wikipedia.

A
The loudspeaker cone is controlled by a
magnet (which is itself controlled by the
GENIE microcontroller) that forces the
cone to move. This movement generates
compression waves in the air, which are
eventually picked up by your ear, forming
the sound you hear.

V / /Ll
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Some types of input signal, such as push switches, can only be
either on or off. These are known as digital signals.

On the GENIE Audio Kit there is a push switch. It is connected
to the input marked by the text ‘A/DO’.

This means that it is the input number 0. The ‘A/D’ prefix
indicates that the GENIE pin to which the input is wired allows
both analogue and digital components to be connected). When
used for digital within the software, it will be called DO.

Use the Digital command to
respond to a digital signals.

The Digital command allows you to make a decision based on
whether the push switch (or any digital signal) is either pressed
(on) or not pressed (off).

When a digital signal is on, it has the value ‘I" whereas when it
is off, it has the value ‘O’.

Double-click on the command to select which digital inputs you
wish to check. GENIE will follow the ‘Y’ (yes) path when the
digital signal matches the chosen pattern, otherwise it will
follow the ‘N’ (no) path. For the GENIE Audio Kit, we suggest
clicking on the right-most input until it shows a ‘1’:

Digital Properties |
D - - - 43210 ok
Cancel
Caption; I
Help

The Digital command should be incorporated into a larger
flowchart. The flowchart tells the GENIE microcontroller what
action to take when it reaches the command.

This can be seen on the right. In the flowchart shown, a tune
will be played whenever the switch is pressed.

Responding to inputs from the push switch 2]

Push switch

A view of the GENIE Audio Kit,
showing the push switch.

A simple flowchart that plays a tune
whenever the push switch is pressed.
The Digital command has two lines
coming out of it, unlike the others.

v
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Not all input signals are digital. Some types of signal, such as
those for temperature or light, can be at a number of different
levels. These are known as analogue signals.

On the GENIE Audio Kit an analogue sensor can be connected
to the ‘A/D4’ input. Although not supplied with the kit, an LDR
is used in this example.

‘A/D4’ means that it is the input number 4. As with the push
switch, the ‘A/D’ prefix indicates that the GENIE pin to which
the input is wired allows both analogue and digital components
to be connected. When used for analogue, it will be called A4.

Use the Analogue command to
respond to analogue signals.

The Analogue command allows you to check an analogue signal
to see if its value lies within a given range.

With GENIE, analogue levels can vary between O (the lowest
level) and 255 (the highest). For the light sensor, low values are
when less light is detected, and high values when it is brighter.

Double-click on the command to select a sensor to check and a
range. GENIE will follow the ‘Y’ (yes) path when the signal is in
range, otherwise it will follow the ‘N’ (no) path.

For example, to test if the light sensor on analogue signal A4 is
between 0 and 100, you should enter the following:

Analogue Properties |
Check analogue sensor: IM j Ok
e Cancel
b I | 1
Help

To allow you to fine-tune the sensor values, you can make use
of the Calibrate Sensor command with a real GENIE Audio Kit.

Responding to inputs from analogue sensors 22

A view of the GENIE Audio Kit,
showing the optional light sensor.

Light sensor
optional, not supplied

A simple flowchart that plays a tune
whenever the light level goes low,
such as when the sensor is covered.
The Analogue command, like the
Digital command, has two out lines.

v

when &4 in 0,100 F 3
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LED connected to output Q2 The GENIE Audio Kit has two light-emitting diode, or
LED, outputs. These LEDs will light up whenever the
appropriate output signal goes high.

Normally the LEDs will flash in time with the music,
however when the music is not playing, you can turn
the LEDs on or off yourself via flowchart commands.

Use the High command to turn

a single LED on.

Use the Low command to turn

Ly
a single LED off.

Use the Outputs command to
control more than one LED.

Cutputs

The two LEDs are connected to the following outputs
on the GENIE 14 microcontroller:

¢ The first LED is connected to output QO.

¢ The second LED is connected to output Q2.
LED connected

to output QO An example can be seen below. In the flowchart, the
first LED is turned on whenever the push switch is

A pressed (and turned off again when it is released).

A view of the GENIE Audio Kit, showing
the two light-emitting diodes (LEDs).

e é
=

The first LED (connected to output QO) has an

extra significance when programming GENIE. A

This output is also referred to as the STATUS Controlling the LED connected to output QO.
output because it will flash whenever a program

is being downloaded to the microchip (it helps

you check that everything is working okay).
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Playing more than one tune 24

< The GENIE microcontroller at the heart of
the GENIE Audio Kit allows even more
complex flowcharts to be programmed.

One example can be seen on the left. It
extends the push switch flowchart so that a

rF s

Flay "Three Blind Mice"

Flay "Brahms"s Lullaby™

@ Flay " Twinkle Twinkle Little Star”

T i

A similar approach is taken in the flowchart on
the right. Here, instead of playing the next tune in
the sequence, a tune is selected based on the
value of a random number between 1 and 3
(inclusive) using the Random command.

Because the flowchart does not check to see if the
value of the random number generated differs
from the one chosen last time, the flowchart will
sometimes play the same tune twice in succession.

You should also note that because MIDI tunes take
up a lot of GENIE’s memory, you may need to
select shorter tunes when playing more than one.

V / /Ll
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different tune will be played (from a list of
three) each time the switch is pressed.

The flowchart works by storing the number
of the next tune to be played in a variable.

Variables are special parts of the GENIE
microcontroller’s memory that allow you
to perform and remember calculations.

These variables can hold any whole number
between O and 255 and are referred to by
different letters of the alphabet. Here we

i are using the first variable, named A.

The flowchart increases the value stored in
variable A each time the switch is pressed
(this is the Inc A command). It then
Compares the value of A to select a tune.

>
O
0 Fromito 3 1

iFa=1

Flay " Three Blind Mice"

-

Flay "Brahms's Lullaby”

-

Flay "Twinkle Twinkle Little Star”

-
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GENIE Rock Star Project

With the product casing and flowchart done, we are now ready to build the GENIE Audio Kit.

< The GENIE Audio Kit consists of a printed circuit
board (PCB, shown on the left) onto which are
placed a number of electronic components.

It is these components that provide the kit with the
ability to play music.

The components must be placed in specific positions
on the PCB. These positions are indicated by a series
of markings and labels on the upper-side of the PCB.
These markings are known as the silk screen.

Once placed, components must then be soldered to
the under-side of the PCB so that they make an
electrical contact.

The picture below will allow you to
identify the types of components that we

will be placing on the PCB. GENIE 14 plus
the chip socket
A detailed list of the components can be

found on the next page.

Download
socket

Light-emitting
diode (LED)
Resistor

Light-dependent
resistor (LDR) optional,
t lied with kit

not supplied wi i Capacitor
Push switch
Transistor

Diode

Printed circuit

board (PCB)
A view of the components mounted

to the top side of the PCB. Note that
the Q1 and Q3 outputs are not used
in the GENIE Rock Star project.
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Building the GENIE Audio Kit 26

A GENIE Audio Kit has the following component parts:

g

Component description

GENIE Audio printed circuit board (PCB)
GENIE 14 (14-pin) integrated circuit (1C)
3xAA battery pack

Battery clip

Loudspeaker

14-pin chip socket

Download socket

330 ohm (330Q) resistor

1,000 Ohm (1kQ) resistor A

10,000 Ohm (10kQ) resistor A view of the underside of the printed
22,000 Ohm (22k€) resistor circuit board. The component legs will
100,000 Ohm (100kQ) resistor be soldered to this side of the board.

220 micro-Farad (220uF) electrolytic capacitor
1N4001 diode

BC337 transistor

Push switch

Green light-emitting diodes (LEDs)

Most of the components are easy to identify (if you need guidance, see
the picture on the previous page). The seven resistors however are more
difficult. These need to be identified by their different colour bands.

The resistor values and colour bands are:

300Q2 Orange, orange, brown and gold
1kQ Brown, black, red and gold
10kQ2  Brown, black, orange and gold
22kQ  Red, red, orange and gold
100kQ2  Brown, black, yellow and gold

Q is the symbol for Ohm, which is a measure of how much it resists the
flow of electricity. A higher value will result in a smaller elecrical flow.

More Information!

More detailed information on the GENlEdA}:—\d;Ee
Kit and printed circuit board can be found
separate GENIE 14 Audio PCB pdf.

i L -
BRG A. -
TR R, el =
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Building the GENIE Audio Kit 27

The following instructions describe how to solder the different components to the printed circuit board.

First, switch on the soldering iron. It will only
take a few minutes for the iron to reach
operating temperature. Once the soldering iron is
hot, carefully clean the soldering iron tip with a
moist (but not too wet) sponge.

Melt some solder at the chamfered end of the
soldering iron tip. This is called ‘tinning’ and it
will aid the flow of solder from the soldering

iron to the copper track on the printed circuit
board and component pins.

Take care when using a
hot soldering iron!

The LDR (not supplied) and LEDs are shown mounted
above the base of the printed circuit board. This is
optional for single-panel designs, but is recommended
for double-panel designs (so that the components are
not obscured by the upper panel).

Next, solder each component onto the board.
We recommend that you fit them in this order:

Resistors

Diode

Download socket

14-pin chip socket (not the GENIE IC)
Transistor

Capacitor

Light-emitting diodes (LEDs)
Light-dependent resistor (LDR) optional
Push switch

WONOUAWN S

Use the picture on page 25 along with the PCB’s
silk screen as guides when placing the different
components. See on the right for further help.

When fitting components such as resistors, we
recommend that you use long-nosed pliers to
bend the legs through 90 degrees. This will make
the components easier to place.

Some of the components need to be fitted the
correct way around:

¢ The diode should be placed so that the stripe
on the diode matches the stripe on the board.

¢ The 14-pin chip socket should be positioned
so that the notch matches the notch shown
on the printed circuit board’s silk screen.

¢+ The flat side of the transistor must match the
flat side shown on the board.

¢+ When fitting the electrolytic capacitor, you
need to ensure that the positive side of the
capacitor (the side without the stripe) is
nearest to the ‘+’ sign on the board.

¢ The LEDs should be fitted so that the flat
edges on the base of the LEDs line up with the
flat edges shown on the board.

¢ So that the LDR (optional, not supplied with
the kit) and LEDs are visible when used with a
double-panel design, we suggest sitting the
bottom of those components above the
printed circuit board (shown left).

To solder a pin, hold the soldering iron onto the
board for a few seconds, then quickly touch the
tip with a small amount of solder.

You should always remember to replace the
soldering iron back into the stand after soldering
and repeat cleaning the tip of the iron with the
moist sponge before the start of each soldering
operation.

Finally, cut off any excess wire or component
legs for a tidy finish.
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With the components mounted on the printed circuit board, the power and loudspeaker connections
can then be soldered.

To wire up the power connections, you need to solder the red
(postive) and black (negative) wires coming from the battery clip
to the ‘+V’ and ‘OV’ holes on the PCB, pictured on the right.

Before soldering, we recommend looping the wires from the
battery clip through the two nearby holes as shown. This acts as a
strain relief, helping to protect the wires from damage.

Power connections
wired to the board. »

< Loudspeaker wired to the board.

For the loudspeaker, two wires will need to be soldered to the ‘SPEAKER’ holes on the PCB, as shown
above. The other end of these wires will be soldered to the two solder tabs on the loudspeaker itself.

For neatness, you can run the wires through one or more of the sound holes. A wire length of about 4
to 5 cm is normally sufficient. Remember to strip the wires at both ends before soldering.

The final step required to complete the building of the GENIE
Audio Kit is to fit the GENIE microcontroller into the chip socket.

As with the chip socket itself, the GENIE microcontroller must be
fitted the correct way around. You will notice that the chip has
both a notch and a ‘dot’ at one end of the chip. These identify
which of the chip’s pins is number 1. Insert the chip so that these
match the notch and ‘1" shown on the printed circuit board.

Care should be taken not to damage the chip’s legs, but you may
need to bend them gently as you insert the chip. The chip should
be seated flat against the top of the socket.

The GENIE chip inserted into the 14-pin
chip socket. The pin 1 ‘dot’ is highlighted. »
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A power cell.

You should now be ready to switch on your circuit.
However, for any electrical or electronic circuit to work
there first needs to be a source of power.

Like most electronic toys, the GENIE Audio Kit gets its
power from standard AA power cells, shown on the left.
These cells are measured by their voltage (voltage is a
measure of the cell’s electrical potential).

The positive end of an
AA cell is usually
marked by a ‘+’ sign.

These AA power cells typically produce an
electrical potential of about 1.5 volts each.

For the GENIE Audio Kit we will need three of
these cells, giving a total of 4.5 volts.

On a circuit diagram this would be represented
by the following circuit symbols:

Spring
i A
| T An empty battery box before the cells
1.5% ' i i
= 45 have been inserted. The negative end of
the power cell should be against the
spring. Notice that the middle spring is at
Circuit symbol for an Circuit symbol for a the other end, which means that the cell
individual power cell. battery of cells. must also go in the other way around:

With the design completed and the electronic
circuit built, the three cells should then be
inserted into the battery box.

As with all power cells, it matters which way
around the AA cell is inserted: there is a

positive end and a negative end. The positive 1\ ~
end is usually marked by a ‘+’ sign. GENIE POWER |\
The cells are placed in series, meaning that the ﬂ 1.5V Y
negative end of the first cell connects to the , -

positive end of the second, and so on.

A
insert the AA cells into the battery box Battery box showing all three cells inserted

The two pictures on the right show how to

and the battery clip connected.

<
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Downloading a program to the GENIE microcontroller 30

Once you have written your flowchart program,
you need to store it on the GENIE chip. Here’s
how you do it:

1 Wire-up the built GENIE circuit board and
connect up a suitable battery power supply.

2 Plug the GENIE cable into the download -

- |
socket on the GENIE circuit board. © {3
C e k=
3 Once done, the Program panel in the Rurnins Liu g
software will then show a ‘Connected’ ek = P
message (see picture a). ol
i i i T e —— /L
4 Click on the Run Live option. Your flowchart &
will be transferred onto the GENIE chip—this 5
is known as downloading (See piCtUre b) Running microcontroller M
+" Your GENIE 14 program has been
downloaded and will start running.
. w About this microcontroller
The green STATUS LED will flash i eaton v
o — Microchip® PIC16F1825 device,
Jﬂﬂ' as th € d own l oa d ta kes p l ace. Click I‘ﬁ:nr detailed information.
L = . . .
= ! MicrocHIP
N It tells you everything is OK! P s
(a) = -
C -|: d _ it % w What would you like to do?
annecte 4 ith your program nov running on the
l‘ EEH I E 14 i @ mctrﬂznntrg\leﬁ you can ﬂpEl’ath an:"'_l
= - - e e e
[on ] 7 B | g ;lilil‘ ‘while: running, the micracontralier wil
( :' 2 not talk bo the computer or update any
I , - of the monitoring panels,
& _; = Click on the Cancel button ta finish,
g @
Refresh g (b) : g 4|L|
Microcontroller connected [ Dol oading § - =
[ [ ][] 3% — |0 | 100 *p®use  * | Ready 7
& GENIE 14 microcontroller has been &
connected ko this computer, WU GEME1S .20 USE RUN —
Click here For detailed information, Em (}"‘7\‘? =
w What would you like to do? |......._ _______ ‘_‘_,.-I =
) e ﬁ & As soon as the program has been
Dovnload and run this program on the = .
connected mi:m:untrull\:er.g § downloaded you Wl” see the
e elewing adanced conmnds e Downloading program — above screen (c) and GENIE will
o N start running your flowchart.
and debugs on a real microcontroller,
Cmwlpevie Your GENIE project is now ready
ontrol the digital inputs and outputs .
e to go! You can disconnect the
L cable and use your GENIE Rock
Star away from the computer.
ﬂ" If you have problems
BQuom “MBum ClRedy g downloading your flowchart,

see the fault-finding and

troubleshooting hints and tips F-\“"S\'\ed‘.

on the next page.
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Fault-finding and troubleshooting 3] 2|

If you are unable to connect to a GENIE microcontroller or download a program, you should go
through the following troubleshooting hints and tips.

A Run the G EN l E troubleshooti ng tool Troubleshooter - GENIE Configuration Tool

. . ‘Wielcome ko the GENIE troubleshooting tool, This
The GENIE troubleshooter will automatically program will help detect and Fix common problems
with cable and netwaork connections,

check your cable and software to ensure that

the computer can access the GENIE cable.

Click o Mext ko continue with the troubleshooter,

¥ find troubleshooting hints and ki
To run the GENIE troubleshooter, choose e SR Toniearomune o meriahenh:
Troubleshoot GENIE... from the Help menu of

the Circuit Wizard or GENIE software.

@ Please note that this troubleshooter can only detect and
fix problems with official GEMIE USE Plug & Play cables,
For third-party serial or USE cables, you will need to
refer to the docurnentation that came with your cable,

If that option is not shown in your version of
the software, you can download it separately
from genieonline.com/cable.

e (A i Mext i Cancel

Step through the on-screen instructions.

B Step through the following checklist of common problems

Cable

* Circuit Wizard, GENIE Design Studio and the GENIE Programming Editor software all check
and report problems involving the cable. If given, follow through on the on-screen advice.

* Unplug the cable, wait a few seconds and then plug it back in. Windows can occasionally fail
to detect that a cable has been inserted.

Power

* Check that the voltage of the battery is sufficient. For this project, the battery voltage should
be in the range of 4.5 volts. You should never connect batteries totalling 6V or more.

* Check the voltage level across the power connections (+V and OV) on the board. This can
identify if there is a problem with the battery clip or battery holder. Ensure that the wiring
has not become loose and the batteries are properly seated in the holder.

Circuit

* Try plugging the cable into another GENIE board if you have one available. When powering
up this circuit, the green STATUS LED should flash once (when properly connected it will flash
repeatedly).

* Try with another GENIE microcontroller if possible.

* Visually inspect the board for bad solder joints or cases where soldering has incorrectly
bridged pins together. Note that for the download socket, the two left-most pins should be
connected together, as should the two right-most pins.

For more troubleshooting hints and tips, please read the separate GENIE Troubleshooting Guide.
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